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KASUTATUD LÜHENDID 

EKI  Eesti Keele Instituut 

ELA Eesti Lennuakadeemia 

ESTERM Eesti Keele Instituudi mitmekeelne terminibaas 

EANS Estonian Air Navigation Services, Lennuliiklusteeninduse Aktsiaselts 

ILS Instrument Landing System, instrumentaalmaandumissüsteem 

PDF Portable Document Format, teisaldatav dokumendiformaat 

RT Riigi Teataja 



 

 

SISSEJUHATUS 

Õppijate kirjalikud tööd kajastavad omandatud teadmisi ning oskusi praktiliste ja teoreetiliste 

küsimuste käsitlemisel. Vormistuslike nõuete järgimine kirjalikes töödes on sama oluline kui töö 

sisuline pool. 

Eesti Lennuakadeemia (edaspidi akadeemia) kirjalike tööde vormistamise juhend on koostatud 

õppurite kirjalike tööde struktuuri ja vormistamise ühtlustamiseks. Kõik akadeemia õppijate poolt 

koostatud kirjalikud tööd (sealhulgas uurimis- ja lõputööd) koostatakse ja vormistatakse käesoleva 

juhendi järgi.  

Käesolevas juhendis on välja toodud näited helehallis kastis. Kirjeldatud tehnilised juhised on 

koostatud eeldusel, et õppija kasutab tekstitöötluse tarkvara MS Word, juhendisse on lisatud 

märksõnad MS Wordi tehnilistele lahendustele nii eesti keeles kui ka kaldkirjas inglise keeles . 

Eestikeelse töö vormistamisel on soovitav kasutada eestikeelset Wordi (Fail → Suvandid → Keel → 

Office’i kuvamiskeel/File → Options → Language → Office display language).  



 

 

1 KIRJALIKE TÖÖDE LIIGITUS 

Kirjalikud tööd käesoleva juhendi mõistes jagunevad pikemateks kirjalikeks töödeks (üle 3 lk) ning 

lühikesteks kirjalikeks töödeks (1-3 lk). Pikemad kirjalikud tööd vormistatakse vähemalt koos 

tiitellehe, sisukorra, sissejuhatuse, sisu peatükkide, kokkuvõtte ja kasutatud allikate loeteluga.  

Vastavalt lõputöödega seonduva tegevuse korraldamise eeskirjale on lõputöö sisu maht 20-25 

lehekülge (sissejuhatus, sisu peatükid, kokkuvõte). Lisade maht ei ole piiratud. 

Uurimistöö (sh lõputöö) koosneb järgmistest osadest:  

● tiitelleht (vt lisa 1), 

● autori deklaratsioon ja juhendaja kinnitus lõputöö kaitsmisele lubamise kohta (vt lisa 2), 

● ingliskeelne lühikokkuvõte tööst (vt lisa 3), 

● sisukord, 

● kasutatud lühendid ja tähised (pole kohustuslik, vormistatakse, kui lühendeid ja tähiseid on 

üle kümne), 

● sissejuhatus (uurimisprobleemi kirjeldus, töö eesmärk, uurimisküsimused või hüpoteesid), 

● teoreetiline ülevaade (põhineb vähemalt kümnel allikal, millest vähemalt kolm on 

teadusartiklid), 

● empiiriline osa  (metoodika kirjeldus, tulemused ja nende analüüs, järeldused, arutelu),  

● kokkuvõte (töö eesmärk, peamised tulemused, uurimisküsimuste vastused või hüpoteeside 

kinnitamine/ ümber lükkamine, töö rakendamise ja arendamise võimalused), 

● kasutatud allikate loetelu, 

● lisad (vajadusel), 

● lihtlitsents lõputöö reprodutseerimiseks ja lõputöö üldsusele kättesaadavaks tegemiseks (vt 

lisa 4). 

Lühikeste kirjalike tööde (1-3 lk) puhul ei vormistata tiitellehte. Töö pealkirjastamiseks kasutatakse 

nummerdamata teise taseme pealkirja (Pealkiri 2/Heading 2), mis joondatakse vasakule. Dokumendi 

päise paremasse serva lisatakse üliõpilase nimi, kursus, eriala ning esitamise kuupäev (vt lisa 5). 



 

 

2 ÜLDNÕUDED  

Kirjalik töö esitatakse üldjuhul elektroonselt pdf-failina formaadis A4 (210 x 297 mm). 

Lehekülgedele jäetakse alla, üles, vasakule ja paremale 2 cm laiune vaba äär (Küljendus → Lehe 

häälestus/Layout→ Margins → Custom → Margins).  

2.1 Stiil ja keel 

Oluline on töö keeleline ja stiililine korrektsus. Keelekasutus peab olema akadeemiline ning kasutada 

tuleb korrektset erialast terminoloogiat. Kõneviis ja -vorm, milles töö kirjutatakse, peab olema ühtne 

kogu töö ulatuses. Autor ei tohiks end asetada ühe poole positsioonile. “Mina” ja “meie” vormi 

(näiteks “meie uurisime”, “ma analüüsisin”) asemel, tuleb kasutada umbisikulist vormi (näiteks “töös 

käsitletakse, analüüsitakse, uuritakse, hinnatakse” või “on käsitletud, analüüsitud jne.”). Eelistatav 

on kindla kõneviisi kasutamine, sest tingiva kõne valdav kasutamine võib jätta mulje, et autor ei ole 

oma seisukohtade õigsuses veendunud. 

Korrektsete eestikeelsete terminite leidmisel tuleb kasutada Eesti Keele Instituudi (edaspidi EKI) 

mitmekeelset terminibaasi ESTERM, mis sisaldab peamiselt Euroopa Liidu ja Eesti Vabariigi 

õigusaktide termineid. Terminibaas koondab üle 50 valdkonna terminoloogiat (sh lennundus) ning 

on kättesaadav aadressil http://termin.eki.ee/esterm/. EKI terminoloogid täiendavad ja ajakohastavad 

ESTERMi pidevalt. (Eesti Keele Instituut, 2022)  

Kui korrektne termin eesti keeles puudub, tuleks mõelda sobilik vaste ning võõrkeelne termin lisada 

sulgudesse. Võõrkeelsed terminid vormistatakse tekstist kaldkirjaga (Kursiiv/Italic).  

2.2 Pealkirjad ja sisukord 

Töö iseseisvaid põhiosi (sisukord, võõrkeelne lühikokkuvõte, sissejuhatus, uus peatükk, kokkuvõte, 

kirjanduse loetelu) alustatakse uuelt leheküljelt (Lisa → Leheküljepiir/Insert → Page Break). 

Pealkirjades lühendeid ei kasutata ja pealkirja lõppu punkti ei panda. Pealkirjad joondatakse lehe 

vasakusse serva (Joonda vasakule/Align Left). Pealkirja ja järgneva (või samal leheküljel eelneva) 

teksti vahe on 12 punkti. Pealkirjade vormistamisel kasutatakse automaatset pealkirja vormingute 

süsteemi (Pealkiri 1, Pealkiri 2, Pealkiri 3/Heading 1, Heading 2, Heading 3), mis on hiljem vajalik 

sisukorra automaatseks vormistamiseks. 

Pealkirjad vormistatakse järgnevalt: 

● Pealkiri 1/Heading 1: Times New Roman, värvus must, 16 punkti, rasvane (Paks/Bold), 

läbiv suur täht (Suurtähtkiri/All caps). Iga põhipeatükk algab uuelt leheküljelt (Rea ja 

lehekülje piirid → Lehekülje piire enne/Line and Page Breaks → Page break before).  

http://termin.eki.ee/esterm/


 

 

1 PEATÜKI PEALKIRI 

● Pealkiri 2/Heading 2: Times New Roman, värvus must, 14 punkti, rasvane; 

1.1 Peatüki pealkiri 
● Pealkiri 3/Heading 3: Times New Roman, värvus must, 12 punkti, rasvane. 

1.1.1 Peatüki pealkiri 

2.3 Teksti vormistamine 

Tekst kirjutatakse kirjastiilis Times New Roman (sh tabelites, joonistel, valemites), kirjasuurusega 

12 punkti. Tekstilõigud joondada mõlema serva järgi (Joonda vasakule/Justify). Töö tekst jaotatada 

lõikudeks lõiguvahega 12 pt (Küljendus → Vahed/Page Layout → Spacing), reavahega 1,5 

(Reasamm/Line Spacing), taanet ei kasutata. Tekstis tekkivate põhjendamatute lünkade korral 

kasutatakse poolitamist (klahvikombinatsioon <Ctrl> + <−>). 

Kõik lehed v.a tiitelleht tuleb nummerdada ja lehekülje number paigutada lehe alla keskele. Tiitelleht 

võetakse nummerdamisel arvesse, kuid leheküljenumbrit tiitellehele ei märgita (Lisa → 

Leheküljenumber → Erinev esileht/Insert → Page Numbers, Different First Page). 



 

 

3 VIITAMINE  

3.1 Üldpõhimõtted 

Lähtematerjalina kasutatakse sageli seisukohti ja andmeid, mis põhinevad varem avaldatule või 

teadaolevale. Vastavalt autoriõiguse seadusele on kirjalikes töödes teiste autorite kogutud andmete, 

seisukohtade jms viitamine kohustuslik. Teiste autorite loomingu kasutamist algallikale viitamata 

nimetatakse plagieerimiseks. Loomevargust ehk plagiaati loetakse Eesti Lennuakadeemia 

õppekorralduseeskirja järgi väärituks käitumiseks, akadeemiliseks petturluseks ja akadeemiliste 

tavade vastu olulisel määral eksimiseks (Eesti Lennuakadeemia õppekorralduseeskiri, 2021). 

Teiste autorite materjale kasutatakse tavaliselt kas neid tsiteerides või refereerides. Tsitaat on teise 

autori tekstist sõnasõnaline väljavõte, mis tuleb esitada jutumärkides, viide tuleb esitada kohe peale 

jutumärkide lõppu. Refereering on teise autori seisukoha ümbersõnastus. Kui viide käib ainult ühe 

lause kohta, pannakse viide enne lause lõpumärki. Kui viidatakse terve lõigu kohta, pannakse viide pärast 

lause lõppu.  

3.2 Viitamisstiilid 

Viitamisstiile on erinevaid, kuid ühes töös kasutatakse läbivalt ühte süsteemi. Akadeemia kirjalike 

tööde vormistamise juhendis on lubatud alljärgnevad viitamisstiilid:  

● nime ja aasta viitamine (APA stiil) - kasutusel enamasti sotsiaalteaduslikes töödes; 

● numbriline viitamine (IEEE stiil) - kasutusel reaalteaduslikes töödes.  

APA stiili korral on tekstisisene viide sulgudes autori perekonnanimi ja teose väljaandmise 

aasta. Kui tegu on autorita allikaga, on viites autori asemel pealkiri ning ilmumisaasta. Kasutatud 

allikate loetelu töö lõpus esitatakse tähestikulises järjekorras autori perekonna- nime järgi. IEEE 

stiili korral on tekstisisene viide nurksulgudes number. Kasutatud allikate loetelus töö lõpus on 

allikad esitatud nummerdatult nende esmakordse tekstis viitamise järjekorras. 

3.3 Viidete haldamine 

Viidete haldamiseks on mitmeid tehnilisi vahendeid. Võib kasutada MS Wordi sisse ehitatud viidete 

haldamise võimalust või eraldiseisvaid viitehaldustarkvarasid nagu Mendeley, Zotero vms.  

Viitekirjete haldamiseks on MS Wordis võimalik kasutada tööriistu, mis asuvad Viited → Tsitaadid 

ja bibliograafia/References → Citations & Bibliography. Viite lisamiseks Lisa tsitaat/Insert Citation, 

viitekirjete haldamiseks Halda allikaid/Manage Source, kasutatud kirjanduse loetelu loomiseks 

Bibliograafia/Bibliography. Kasutatud kirjanduse loetelu kirjaliku töö lõpus peab sisaldama kõiki 

https://apastyle.apa.org/style-grammar-guidelines/references/examples
https://ieeeauthorcenter.ieee.org/wp-content/uploads/IEEE-Reference-Guide.pdf


 

 

allikaid, millele on töös viidatud ja vastupidi – igale loetelus leiduvale allikale peab töös leiduma 

viide.  

Viitehaldur on tarkvarapakett, mis võimaldab koguda, korrastada ja kasutada bibliograafilisi viiteid. 

Viitehaldureid saab tavaliselt "ühendada" otse tekstitöötlustarkvara või veebibrauseritega. Kui 

sisestate antud viitega seotud koodi, loovad viitehaldurid automaatselt bibliograafiad, mis on 

vormindatud vastavalt ajakirja või stiilijuhendi spetsiifilistele nõuetele. 

Mendeley (mendeley.com) on Elsevieri kirjastuse viidete haldur,  mis võimaldab: 

● luua endale viidete kogu, mida on lihtne organiseerida ja hallata, 

● lugeda, annoteerida ning varustada märkmete ja kommentaaridega oma viidetele lisatud PDF-

faile, 

● lihtsalt ja kiiresti lisada tekstisiseseid viiteid kirjutamise ajal ning koostada ühe hiireklikiga 

viidatud allikate loetelu, 

● suhelda teistega oma uurimisvaldkonnas (nt töö juhendajaga), luua oma uurimisrühm või 

ühineda teiste uurimisrühmadega. (Viitehaldustarkvarad, kuupäev puudub) 

Mendeley ingliskeelsed juhendid: http://community.mendeley.com/guides.  

https://www.mendeley.com/
http://community.mendeley.com/guides


 

 

4 KIRJALIKE TÖÖDE ERINEVATE OSADE VORMISTAMINE 

4.1 Lühendid 

Pikki nimesid ja mõisteid on soovitatav nende korduvkasutamise korral lühendada, enne lühendi 

loomist tuleks see tekstis lahti kirjutada. Kui lühendeid kirjalikus töös on üle kümne, siis tuleks need 

seletustega esitada eraldi ka loeteluna (vt vormistust käesoleva juhendi kasutatud lühendite loetelust). 

Üldkasutatavaid lühendeid lühendite loetelus ei esitata (nt a, e, jne, m, mln, ptk), üldkasutatavate 

lühendite loetelu on kättesaadav EKI kodulehelt  (Erelt, Erelt, & Ross, 2007).  

Instrumentaalmaandumissüsteem (inglise keeles Instrument Landing System, edaspidi ILS) on 

täppislähenemisel kasutatav navigatsioonisüsteem. 

4.2 Loetelud 

Loetelu igal tasandil peab olema vähemalt kaks alapunkti. Kogu töö ulatuses tuleks kasutada ühtset 

loetelude esitust ning vältida paljude erinevate stiilide kasutamist. Loeteluga pole sobiv peatükki lõpetada 

või alustada. Loetelu koostades tuleb kaaluda, kuidas liita loetelu loomulikul viisil ümbritseva tekstiga. 

Loetelud tähistatakse numbritega, väiketähtedega või täpploendiga. Loetelude trükkimisel on reavahe 1,5 

ja lõiguvahe 0. Vältida tuleb loeteludega liialdamist. Kui loetelu koosneb üksikutest sõnadest või 

lühikestest fraasidest, siis loetelu punktid eraldatakse komaga. 

Akadeemia üliõpilaskohale konkureerimiseks: 

● peab kandidaadil olema keskharidus või sellele vastav välisriigi kvalifikatsioon, 

● tuleb kandidaadil esitada sisseastumisavaldus, 

● peab kandidaat täitma keeleoskuse nõuded. 

Kui kasvõi üks loetelu punktidest sisaldab koma(sid) või muid kirjavahemärke, tuleb eraldusmärgina 

kasutada semikoolonit. Alustatakse väikese tähega ning sel juhul tähistatakse järjekorda 

ümarsulgudega varustatud numbrite või tähtedega. 

Kui kasvõi üks loetelu punktidest koosneb kahest või enamast lausest, siis asendatakse sulg 

järjekorranumbri järel punktiga. Kui mõni loetelu punkt sisaldab omakorda loetelu, siis tähistatakse 

üldisema loetelu punktide järjekorda tingimata numbritega, alluva loetelu punkte aga tähtedega. 

4.3 Tabelid 

Kõik töös esinevad tabelid sildistatakse (silt “Tabel") ning nummerdatakse läbivalt kogu töö ulatuses 

(mida soovitatakse kuni 10 tabeli korral) või suurema hulga tabelite korral üksikute peatükkide 

ulatuses. Näiteks “Tabel 1.” või “Tabel 3.4”. Sama moodust on soovitatav kasutada ka jooniste ja 

http://www.eki.ee/books/ekk09/index.php?p=2&p1=9&id=67


 

 

valemite tähistamisel. Tabelite sildistamiseks ja nummerdamiseks tuleb kasutada Viited → Lisa 

pealdis/References → Insert Caption, tabelite pealkirjade vormistamisel kasutatakse laadi 

Pealdis/Caption: kirjasuurus 12 pt, reavahega 1,5, joondus vasakule, tabeli pealkirja ja tabeli vahele 

jätta 6-punktine vahe. Tabeli sees olev tekst kirjutatakse kirjasuurusega 10 pt kuni 12 pt, reavahega 

üks (Ühekordne/Single). Tabeli tekst kirjutatakse samas keeles, mis keeles on töö kirjutatud (vt tabel 

1).  

Tabel 1. Keskmine brutokuupalk aastatel 2011 – 2016, eurodes (Statistikaamet, 2017) 
 

 2011 2012 2013 2014 2015 2016  

I kvartal 792 847 900 966 1 010 1 091  

II kvartal 857 900 976 1 023 1 082 1 163  

III kvartal 809 855 930 977 1 045 1 119  

IV kvartal 865 916 986 1 039 1 105 1 182  

Tabelites esitatud andmed tuleb siduda tekstiga (näiteks „Tabel 3 iseloomustab...“ või „vt tabel 8“). 

Viitamiseks kasuta Viited → Ristviide/References → Cross-reference. Tabeli pealkirjas märgitakse 

kasutatud andmete allikas või allikad. 

Tekstisiseste andmetabelite poolitamist välditakse ehk jälgitakse, et tabel mahuks ühele lehele. Suuri 

andmetabeleid kajastatakse lisades. Kui tabel ulatub üle mitme lehe, siis tabeli päiserida korratakse 

(Korda päisereana iga lehekülje alguses/Repeat header rows).  

4.4 Joonised 

Joonisteks on illustratsioonid, diagrammid, graafikud, kaardid, joonistused, skeemid, pildid või fotod. 

Igal joonisel peab olema allkiri (allkirja sisu graafikul ei dubleerita). Kõik joonised nummerdatakse 

analoogiliselt tabelitega. Jooniste sildistamiseks ja nummerdamiseks kasuta Viited → Lisa 

pealdis/References → Insert Caption. Sildiks kasuta „Joonis“, joonise allkiri joondatakse vasakule. 

Joonise allkiri kirjutatakse kirjasuurusega 12 pt, reavahega 1,5. Allkirja ja joonise vahele jätta 6-

punktine vahe. Joonise tekstid kirjutatakse samas keeles, mis keeles on töö kirjutatud.  

Igale joonisele tuleb töö tekstis viidata (Viited → Ristviide/References → Cross-reference). Joonis 

paikneb tekstis sobivas kohas pärast viidet. Analoogiliselt tabeliga tuleb joonise juures vajadusel 

näidata kasutatud andmete allikas. Üldjuhul kasutatakse autori koostatud jooniseid.   

 



 

 

 
Joonis 1. Google’i aktsia hind jaanuaris 2023 (Alphabet Inc. (GOOGL), 2023) 

4.5 Valemid 

Valemid ja nendes kasutatud sümbolid järgnevas tekstis kirjutatakse kaldkirjas (Kursiiv/Italic) 

kirjasuurusega 12 punkti. Valemite vormistamisel kasutatakse valemiredaktorit (Lisa → 

Võrrand/Insert → Equation). Valemid töös nummerdatakse, valemi number paigutatakse valemiga 

samale reale (soovitatavalt paremale) sulgudesse. Valemites ei tooda mõõtühikuid, need esitatakse 

valemites kasutatud sümbolite seletustes ning need kirjutatakse püstkirjas. Valemi sümbolite seletus 

algab sõnaga “kus” (ilma järgneva koolonita) ning seletused kirjutatakse ülevaatlikkuse mõttes 

üksteise alla. Igas uues valemis selgitatakse ainult esmakordselt esinevaid tähistusi. 

Lainepikkus (λ) avaldub järgmisest valemist: 

 𝜆𝜆 =  𝑐𝑐
𝑓𝑓

, (1) 

kus  λ (m) – lainepikkus,  
 

 c (m/s) – valguse kiirus,  
 

 f (Hz) – sagedus. 

4.6 Lisad 

Lisadesse tuleb paigutada need arvandmed ja muud materjalid, mis on vajalikud probleemi 

käsitlemiseks, kuid mille esitamiseks tekstis pole otsest vajadust või kui on tegemist väga mahuka 

materjaliga (uurimuse tugimaterjalid, ankeedid, tabelid jne). 

Lisad nummerdatakse neile viitamise järjekorras araabia numbritega ning sellele järgneb lisa pealkiri 

joondusega vasakule. Punkti pealkirja lõppu ei panda. Iga lisa peab algama uuelt leheküljelt. Kui lisas 

olev tekst, pilt, tabel vms ei ole autori oma, tuleb selle päritolu näidata täpse allikaviitega. 

Lisa 1. Tiitellehe näidis 



 

 

Lisade pealkirjade loetelu ei esitata sisukorras. Esimese lisa ette tuleb paigutada leht pealkirjaga 

„Lisad“ ja esitada sellel lisade pealkirjade loetelu (vt Lisad). Lisade vormistamiseks kasuta Wordis 

Viited → Lisa pealdis/Insert Caption, sildiks „Lisa“ ning lisade loetelu genereerimiseks Lisa 

illustratsiooniloend/Insert Table of Figures). 
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Lisa 2. Autori deklaratsioon ja juhendaja kinnitus lõputöö kaitsmisele lubamise kohta 

 

Autorideklaratsioon 
Kinnitan, et olen koostanud käesoleva töö iseseisvalt. Kõik käesoleva töö koostamisel kasutatud teiste 

autorite tööd, põhimõttelised seisukohad, kirjandusallikatest ja mujalt pärinevad andmed on 

korrektselt viidatud.  
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Autor: Eesnimi Perenimi 

 

Juhendaja kinnitus lõputöö kaitsmisele lubamise kohta 
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1 

 

SUMMARY 

Lõputöö ingliskeelne pealkiri 

Stating the goal of the thesis, providing background information, why important, the method, the 

number of chapters 

The content of chapters (in the list format): 

Chapter 1 describes / addresses / contains / covers / discusses / provides / presents / explores / 

examines etc. 

Present the findings / results / most important facts 

Make suggestions for further research, where the results can be used 

Optional: Expressing gratitude.  

  

 
1

 Impersonal – “The author” 
Present tenses and passive used 
To add more points: Also, What is more, Furthermore, In addition to this/that 
To introduce contrasting viewpoints: On the other hand, However, Nevertheless, In spite of 
To introduce examples: for example, for instance, such as 
To conclude: To sum up, In conclusion, To conclude 
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Mina, Eesnimi Perenimi, annan Eesti Lennuakadeemiale tasuta loa (lihtlitsentsi) enda loodud teose 

UURIMISTÖÖ PEALKIRI 

mille juhendaja on Eesnimi Perenimi, 

1.1. reprodutseerimiseks säilitamise ja üldsusele kättesaadavaks tegemise eesmärgil, sealhulgas 

digitaalarhiivi Eesti Lennuakadeemia Raamatukogu Rikswebis lisamise eesmärgil kuni 

autoriõiguse kehtivuse tähtaja lõppemiseni; 

1.2. Eesti Lennuakadeemia Raamatukogu registreeritud kasutajatele kättesaadavaks tegemiseks 

Eesti Lennuakadeemia Raamatukogu Rikswebis veebikeskkonna kaudu kuni autoriõiguse 

kehtivuse tähtaja lõppemiseni. 

2. Olen teadlik, et punktis 1 nimetatud õigused jäävad alles ka autorile. 

3. Kinnitan, et lihtlitsentsi andmisega ei rikuta teiste isikute intellektuaalomandi ega 
isikuandmete kaitse seadusest tulenevaid õigusi. 

 
/allkirjastatud digitaalselt/ 

Autor: Eesnimi Perenimi 
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Eesnimi Perenimi 

x. kursus 

Õppekava (ja eriala) nimetus 

DD.MM.YYYY 

Lorem ipsum 

„Lorem ipsum is a pseudo-Latin text used in web design, typography, layout, and printing in place 

of English to emphasise design elements over content. It's also called placeholder (or filler) text.“ [1] 

… 

… [2] 

… 

… 

 

 

Kasutatud materjalid 

1. Lorem ipsum [http://generator.lorem-ipsum.info/] Kasutamise kuupäev: 27.11.2013 
2. … 
 

http://generator.lorem-ipsum.info/
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